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Demo Quick Start

Welcome to the NiagaraAX Framework! This document will get you up and running with a demo station
using NiagaraAX-3.8 Workbench. If you are new to Niagara, then you might want to check out the
NiagaraAX User Guide section “Tour of the Workbench GUT"

If you are a Java software developer working with the NiagaraAX Framework, you should also see the
Niagara Developer Guide for details on Baja and Java usage in NiagaraAX.

The following sections are in this Demo Quick Start document:

+  “Get the Demo Up and Running” on page 1-2

+  “Tips on Navigating the Demo” on page 1-7
+  “Learning More” on page 1-8

+  “Stopping the Demo Station” on page 1-9

+  “Troubleshooting the Demo” on page 1-10
+  “Tree not visible” on page 1-10
+  “Cannot open Platform” on page 1-11
+  “Stations missing in Application Director” on page 1-12
+  “Cannot open Station” on page 1-12

+  “Demo stations security notes” on page 1-13

+  “SSLand certificate notes in AX-3.8” on page 1-13
+  “Browser access notes” on page 1-14
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Get the Demo Up and Running

Get the Demo Up and Running

Step1  Start Workbench.
Your host PC appears in the Nav tree (My Host in left pane).
## Miagara Workbench EI@
File Edit Search Bookmarks Tools Window Help
Tl | D @ (2 &~ 4 ] 88 »
2 e |
- & |Nav |
2 Bl Niagara Workbench
= Licensed to Tridium-Training, Tech Pubs
B 52! My Host : sc-400
Note: Ifyou don’t see the Nav tree, turn on ‘side bars.” See “Tree not visible” on page 1-10.
Step2  Right-click your host in the Nav tree.
From the popup menu, click: Open Platform.
A Connect popup appears, typically with Type set to & Platform SSL Connection
File Edit Search Bookmarks Tools Window Help
4- -0 | D-Of% (2 &~ 4 (]
a
- |8 [Nav
02 [@v] Niagara Workbench
_a Licensed to Tridium-Training, Tech Pubs
Disconnect
B < -
& Open Station / ® Open Platform with SSL
Connect to the host's secure platform daesmaon
5‘ My Spy Session
2 Refresh Tree Mode Type ?*n
) G Into Host [17 [+][ze=100 ] -
1
In the @& Connect popup (above), click OK.
Step3  Inthe Authentication popup, type your Windows administrator-level username and password.
File Edit Search Bookmarks Tools Window Help
4d- -0 | D-©@ (2 &- 4 o
a3l 28 Authentication @
il iz / ) Authentication
: @ Logon required for access n C|'I
a8 e Lij Realm chnical Public
-E‘ MName GLOBAL
Scheme  HTTP-Basic
Credentials
[[] Remember these credentials
Note: Ifyou click the “Remember these credentials” checkbox, future access of the Platform node will authenticate

without re-entering credentials (Username and Password). Prior to AX-3.7 (and 2013 security updates),
this was set by default. However, now this is cleared by default—you must set it, if desired.

Click OK.
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The first time you open your platform with SSL, a popup Identity Verification warningappears.

NiagaraAX'3‘8

Identity Verification
. NiagaraAX

* Unable to verify host identity

=

The supplied certificate could not be validated:
- the certificate was issued for a different address
- the certificate was not issued by a trusted authority

-
Properties: =
Version v3
Serial Number 47 Oe 05 &9 bb a2 79 49 1d 5d fa Te
Issued By NiagarahX
Issuer DN CN=NiagaralX,0=Tridium, C=U3
Subject HiagarahX
Subject DN CH=NiagarahX, 0=Tridium, C=U3 ==
Not Before Wed Nov 06 22:25:32 EST 2013
Not After Thu Nov 06 22:25:32 EST 2014
Key Algorithm RSR
Key Size 1024
Signature Algorithm SHAZS6WITHRSA
Signature Size 128 =
Danirs Crnebesinks Srhdant Timas Fnd Fntito |

/] [ [

Click Accept. This creates an “allowed hosts” certificate exemption for Workbench on this port (5011,
if using defaults). For related details, see “SSL and certificate notes in AX-3.8” on page 1-13.

Note: If connect Type was changed from 8 Platform SSL Connectionto & Platform Connection
(in the Connect popup shown in Step 2), such a warning does not appear. It also does not appear again
(after accepting it) in future local platform SSL connections—at least for the duration of this certificate.

Note:

Step 4

Various platform views are listed in the right-side View pane. In the Nav tree, if you expand My Host you
now see a Platform node.

File Edit Search Bookmarks Tools Window Help

<« -o-[m-

DRz -0 | &

L

== My File System
5 My Modules
& Platform

Name

Description B

@ Application Director

q Certificate Management
¥ DDNS Configuration

A Lexicon Installer

| License Manager

|5 Platform Administration
() Software Manager

C[E TCR{IP Configuration
(% User Manager

== Remote File System

Contral applications and access console output

Manage ¥.509 Certificates and Host Exemptions.

Configure the way DDNS operates.

Install lexicons to support additional languages

Manage licenses and certificates

Update the platform daemon's port or credentials, or setits|
Instal software to the remote host

Manage the host's TCP/IP settings

Manage the local OF users and groups

The remote host's file system

If your Platform does not open, it may be a host login issue, or the Niagara platform daemon may be
stopped. See “Cannot open Platform” on page 1-11.

In the view pane, double-click the Application Director.

= 2

[«

I Application Director

=52 My Host : sc-400
; My File System
€13 My Modules
= Platform

[+] Certificate Management
° DDNS Configuration
A Lexicon Installer

& | License Manager

|5 Platform Administration
) Software Manager

CfF TCP/IP Configuration
& User Manager

=i Remote File System

Control applications and access console output
Manage ¥.509 Certificates and Host Exemptions.
Configure the way DDNS operates.

Install lexicons to support additional languages
Manage licenses and certificates

Update the platform daemon's port or credentials, or set it
Install software to the remote host
Manage the host's TCR/IP settings
Manage the local 05 users and groups
The remote hosts file system

The Application Director appears in the view and lists available stations.
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Demo Quick Start

Note:
Step 5

The demo station appears with a status of “Idle”

November 14,2013

= [: MNav

Connected to

localhost

M

[=] demoAppliance

station | Ide

nfahttp=n/a,https=nfa

4

[T

false

[ Auto-Start

Start

Restart on Failure

Stop

-

If no stations list, a divider may need moving. See “Stations missing in Application Director” on page 1-12.

Right-click the demo station in the Application Director.
From the popup menu, click Start (or, with the demo station selected, click the right-side Start

button).

Connected to

localhost

fox=n/a,foxs

. I

=n/ahttp=n/a,https=n/a

false

Clear Output

[] Auto-Start

Start

Restart on Failure

Stop

-

The demo status changes to “Starting,” and messages start appearing in the view.

Connected to localhost

'a,http=n/a,https=n/a

false

4

WARNING
MESSAGE
MESSAGE
MESSAGE
MESSAGE

08-Now-13
08-Now-13
08-Nov-13
08-Howv-13
08-Now-13

EST] [timezone] No niagara.t|
EST] [sys.registry] Up-to-da
EST] [ays.registry] Loaded [
EST] [sys] Baja runtime boot;
EST] [3y3] Loading "D:\Niaga

[] Auto-Start [«
Restart on Failure
Start

Stop
Restart

After several seconds, the demo station status changes to “Running”

Connected to localhost

[=] demoAppliance station Idle

fox=n/a,foxs=n/a http=n/a https=nja  false true

4

WARNING
MESSAGE
MESSAGE
MESSAGE
MESSAGE
MESSAGE
MESSAGE

[16:30:

MESSAGE
| | MESSAGE
MESSAGE
MESSAGE
MESSAGE
MESSAGE
MESSAGE
MESSAGE [16:30:

21

25

08-Howv-13
08-Now-13
08-Now-13
08-Now-13
08-Nov-13
08-Howv-13
08-Now-13
08-Now-13
08-Now-13
08-Nov-13
08-Howv-13
08-Now-13
08-Now-13
08-Now-13
08-Nov-13

niagara>MESSAGE [16:30:25 08-Nov-13 EST] [fox] FOXS serw
MESSAGE [16:30:25 08-Now-13 EST] [web.server] HITPS serw
MESSAGE [16:30:26 08-Nowv-13 EST] [history.db] Starting a|

EST] [timezone] No niagara.t|
EST] [aya.registry] Up-to-da
EST] [sys.registry] Loaded [
EST] [sys] Baja runtime boot;
EST] [sys] Loading "D:\Niaga
EST] [sys] Loaded {1357ms)

EST] [alarm.database] Loadin
EST] [alarm.database] Loaded|
EST] [sy3] Services Initiali
EST] [sys.mixin] Updated [1&
EST] [sys.mixin] Updated [Om|
EST] [web.server] HITP serwve
EST] [fox] FOX server starte
EST] [sys] Niagara Runtime E|
EST] [3y3] *** Station Start;

[] Auto-Start =
Restart on Failure

[swveros |

oz Do
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NiagaraAX'3‘8

Step 6

Note:

Step 7

Right-click you

r host again in the Nav tree.

From the popup menu, click: Open Station

A Connect popup appears, typically with Type set to ¥ Station SSL Connection

= =]

[=

Nav

Connected to localhost

(@ [@]

My Host : sc-400

&0 My Mod|

MyFile§  Disconnect

= Open Platform

Status | Details
station [Running fox=1911,ft

£ Platform ##5 Connect ERE
o Open Station

Open Station with SSL E
5 My spy Connect to station using fox over S5L. m
2 Refresh Tree Node Session ]
[E) Go Into Type Ffi Station S5L Connection | T | K
MESSAGE [16:4 - . M
MESSAGE [16:4 Host 1P [~][rasiiTreweBs1 | L

MESSAGE [16:4 Port [1211 |
MESSAGE [16:4 H
MESSAGE [16:4 py
MESSAGE [16:4 [ ox ] -m =
MESSAGE [16:4| Ly E
niagara>MESSASE IO OO 7n Or=NOV=TS T [WED- SETVET T UITFT SoT Ve

In the @ Connect popup (above), click OK.

The first time you open your station with SSL, a popup Identity Verification warning appears.

=

Identity Verification
. NiagaraAX
* ' Unable to verify host identity

The supplied certificate could not be validated:

- the certificate was issued for a different address
- the certificate was not issued by a trusted authority

3
Properties: =
Version v3
Serial Number 47 Oe 05 69 bk a3 79 49 1d 54 fa Te
Issued By NiagaralX
Issuer DN CN=Niagaral¥,0=Tridium,C=U35
Subject NiagaralX
Subject DN CH=Wiagaral¥,0=Tridium, C=U3 =
Nat Before Wed Nov 06 22:25:32 EST 2013
Not After Thu Nov 06 22:25:32 EST 2014
Key Algorithm R3SR
Key Size 1024
Signature Algorithm SHRZ56WITHRSA
Signature Size 128 )
e e Trhdant Timas Fnd Barito L=l

< [ [»]

Click Accept. This creates an “allowed hosts” certificate exemption for Workbench on this port (4911,
if using defaults). For related details, see “SSL and certificate notes in AX-3.8” on page 1-13.

If connect Type was changed from ¥ Station SSL Connectionfo ¥ Station Connection (in
the Connect popup shown in Step 6), such a warning does not appear. It also does not appear again (after
accepting it) in future local SSL connections to this station—at least for the duration of this certificate.

An Authentication popup appears (here, you login using a station user account).

In the Username field, type admin

- i Mav Connected to localhost
911,http=30,https
demoApg ‘a,https=n/a fal
T 3 Authentication (=)
U{J My Modules = Authentication _ _
ogon req.e!l for access liagara.timezor
aplatﬁ”m MESSAGE Tp-to-date [34
- station (demo) ﬁgg:g% Realm I.‘Dﬂdel;d [ngs;][
Fime boote =
MESSAGE Name  local: [foxs: [D:\Niagara\Nid
MESSAGE Scheme  Fox (digest) L326ma)
MESSAGE _ k] Loading...
MESSAGE || Credentials E] Loaded [Oms
22536E | eemame [zaicietized
ate ma
MESSAGE Password [ | hated [Oms]
MESSAGE - [TP server stay
MESSAGE D Remember these credentials Lr started on o
MESSAGE untime Enviror
MESSAGE fon Started (3§
niagara>y FOXS server std
MESSAGE TIPS server stg

Leave Password blank (for just this one time), and click OK.

1-5
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Demo Quick Start

Note:

Step 8

Note:

Step 9

Note:

November 14,2013

A “Reset Password” popup dialog appears.

Nav Connected to localhost

L @ MName Typ Ias - u

M‘! Host : sc-400 demoApy — 3 https=n/a fals
My Fie System | ] St Fasswor —
My Modules ° Reset Password
5 Platform Wmﬁggigg Set new account password agaraatlme?gr
lp-to-date 1
B+ station (demo) | | MESSRGE . ) paded [110ms]
ME3SRGE Please enter a new password, e booted (°1
MESSAGE ‘Your password must contain: :\Niagara\Nig
MESSAGE - atleast 10 character(s) Gdms)
MESSAGE - atleast 1 digit{s) Loading...
MESSAGE -atleast 1 lower case character(s) Loaded [Oms,
ggg:gg - atleast 1 upper case character(s) Eé;lalié;:]i &

MESSAGE ted [Oms]
| I
MESSAGE asswer P server starg

MESSAGE Intime Environ

MESSAGE In Started (34
niagara>l X5 server stg
MESSAGE PS server stg

This “Reset Password” request occurs because all users in the AX-3.8 demo station have their account set
to require a password reset upon first login (a change from the demo station in releases prior to AX-3.8).
You must enter a new password for the admin user in the next step.

For related details, see “Demo stations security notes” on page 1-13.
Type a new ‘strong” password in the “Password” field, and repeat it again in the second “Confirm” field.
Reset Password @
p Reset Password
Set new account password
Please enter a new password,

“Your password must contain:

-atleast 10 character(s)

- atleast 1 digit(s)

-atleast 1 lower case character(s)
-atleast 1 upper case character(s)

Conten

Follow the strong password rules given in the popup (note that “digit” means a numeral). The demo
station’s User Service is configured to require strong passwords. Note that in AX-3.8, these strong
password rules are also configurable, via a “Password Configuration” component under the User Service.

Make this password unique, and be sure to remember (or make a note of) it!

When your matching password entries meet these rules, the OK button is enabled. Click OK.
Again, see the section “Demo stations security notes” on page 1-13.

The demo station opens in the view and appears as a node in the Tree.

|= I |
v |l& |Nav
I @ MName | Description | B
- ﬁ Home  Navigation tree defined by nav file
B My Host : sc-400 (dema) Config  The station configuration database
My File System =i Files File System accessed over Fox session
ﬁ spy Diagnostics information for remote VM
00 My Modues #3 History | History database
% Platform
4
Property |Value B
Station Name demo
Host VASILTFGWPBS1/172.19,109.78
Host Model Workstation
Host 1d Win-5BE1-B094-FC24-3440
Nizgara Yersion 3.8.34
Java Version Java HotSpot{TM) 64-Bit Server WM 24.45-h08

Ifthe “Reset Password” dialog does not appear and the station does not open, some other login issue is likely.
See “Cannot open Station” on page 1-12.

NiagaraAX'3'8
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Step 10  To explore the station, just click on expand controls in the Tree to browse the station’s hierarchy. Simply
double-click on items of interest to see item contents in the view.

[= 3 a L]
= |2 |Nav

08
[EHEE My Host : sc-400 (derl
==| My File System
40 My Modules
& Flatform
Etﬁ Station (dema)

s

EHEl Config @ /‘
1a9art.
B services FRAMEWORK™®

& Drivers

BHLD) sampler
BHZ) Programs [+ |

Note: The Config node represents the actual station database, and holds components with wire sheet and
property sheets views, among many other view types.
See “Tips on Navigating the Demo” on page 1-7 for some of the many Workbench navigation features.

Note: You can exit Workbench without stopping the demo station, and then restart Workbench and reopen the

demo again (until your PC is rebooted). Start with Step 6 on page 5.
If you'd rather, you can also stop the demo station first. See “Stopping the Demo Station” on page 1-9 for

more details.

Tips on Navigating the Demo
Consider the Workbench GUI as the NiagaraAX “super browser,” combined with other familiar
Windows-like applications (e.g. Windows Explorer).

& Niagara W
File Edit Sg

& Niagara Workbench

a .
Fl\e Edit Search Bool = Miagass WAIkLE e

FI|E Edit Search Bookmarks Tools Window|

4- D'Iﬁ_h O-Hr s

l-d & e
= ﬁ 5 Nav
Ehs2 My Host g - MeterRoom
Bl My Fif | M2 My Host : VAS 1L — ey

# Niagara Workbench
Flle Edit Search Boakmarks Tools WlndoN W\resheet Help

i 2 0- "2 0[5 W@l
T cousmaunt | i e LS FsAgnt e e

- [ Logic” -1
. ﬁ PxHome
DamperPosition
l & local: |foxs: e
= & local: [platformssl: Out 57.30 % {ok}
L= DamperGen [; IniD =

@ | about.himl Sine Wave inis 57.30 %
: Out 573 {ok Inig -1

On the toolbar, use the Back and Forward buttons to retrace or advance your steps. Both of these
buttons offer a “visited” drop-down menu.

Also,an Up Level button is available when you are at some child level, say under a station’s Config node
(also with its own drop-down menu).

NiagaraAX'3‘8 1-7
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Learning More

Note:

Note:

1-8
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Instead of a normal “text-only” URL address bar, Workbench has a graphical locator bar.

= %

i Logc i HousingUinit - i

> | [Nav

L2 @]

B My Modules
BB Flatform

y @
@ scheduleOverride |2 T
27 % {ok}
E}-_—ﬁ My Host : sc-400 (demo]— DamperGen =5 vavZones - (r:k.l
B My File System e e ——ll ) MeterRoom iz

[E5) Lighting

|| Schedule

&% Find

L @

- FilterGe:
B8 Station (dema) Fharee Al E
] I
1| Wire Sheet
DamperPosition m !
Mumeric Writsble ® [ Category Sheet
Ou 7B.52 % [ok} @ 15 e
[mperGen | Tn = B Slot Sheet
e Wave IniS 75.52 % {ok ] F| Link Sheet
t 78.5 {ok_ ni6 -
New View
Filter @ T
= = Numecic Writahls

As shown above, the locator bar displays not only the full path of the item in view, but also features a drop-
down menu (at every level) that lists immediate child items.

The right-side of the locator bar is the view selector, another drop-down menu that lists all available
views for the item currently shown in the view pane.

Right-click menus are woven throughout the Workbench interface, both in the sidebar (Nav tree, by
default) as well as in main views.

* |iz |Nav Config (Station)

i @ O @ StationMame  [demo
O & SysInfo » o

PxHome Folder
=] ﬁ? Services

=52 My Host : sc-400 (demo)
'E My File System

Q{J My Madules Service Container

8 ruton
E—Eﬁ Station (dema) P B Property Sheet k
- Home L o

2 EFV Log History Service
i rogram Service

ob Service

B frvice User Service

~trvice Web Service
Ja¥ila =] Email it

Often, multiple ways exist to perform the same operations, either working in the sidebar (e.g. Tree), main
view, or from the menu bar or toolbar. For example, this document provides mostly “right-click instruc-
tions”

Learning More

To learn more about NiagaraAX, see the online Help. To learn more about features of Workbench, see
the User Guide sections “About Workbench” and “Tour of the Workbench GUL”

For details about SSL and NiagaraAX, see the NiagaraAX SSL Connectivity Guide.

Please understand that NiagaraAX Help evolves as a “work in progress,” with many topics still placeholders
(or with minimal details). However, we are committed to delivering a consistent, unified, Help system to
lessen the need for printed documents (PDFs). Furthermore, as PDFs about NiagaraAX become available,
they will reflect the same source content as found in the online Help.

NiagaraAX'3'8
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Stopping the Demo Station

Learning More

Note: Ifyou exited Workbench without first stopping the station, and you have not since rebooted your computer

(or stopped/restarted the Niagara platform daemon), the station remains running.

Stepl  In Workbench, expand your host’s Plat form in the Nav tree.

Double-click the Application Director.

=52 My Host @ sc-400 (dema)
==| My File System

40 My Modules

B & Platform
@

-~ Certificate nagem

----,p‘ DDNS Configuration

A Lexicon Installer

- | License Manager

(j Software Manager
L& TCP/IP Configuration
& User Manager
[#}==1 Remote File System
E}-Eﬁ Station (dema)

|54 Platform Administratiq

ﬁ Home

=

demoAppliance station  Idle

= B [=
- |3 | Nav Connected to localhost
7 g .53 My Netw Mame Type Status

fox=n/a,foxs=n/ahttp=n/a,https=nfa fals]

4

WARNING [16:41:17 10-Nov-13

MESSAGE 1:17 10-Nowv-13
MESSAGE :17 10-Nowv-13
MESSAGE :18 10-Nov-13
MESSAGE 18 10-Nov-13
MESSAGE :13 10-Nowv-13
MESSAGE :20 10-Nowv-13
MESSAGE :20 10-Nowv-13
MESSAGE :20 10-Nov-13
MESSAGE :20 10-Nov-13
MESSAGE :20 10-Nowv-13
MESSAGE :20 10-Nowv-13
MESSAGE :20 10-Nowv-13
MESSAGE :20 10-Nov-13

MESSRGE [16:41:20 10-Nov-13

MESSAGE [16:41:21 10-Nov-13
MESSAGE [16:41:22 10-Nov-13
MESSAGE [16:41:22 10-Nov-13
WRARNTNG [16:47:48 10-Nowv-1

niagara>MESSAGE [16:41:21 10-Nov-13 EST] [fox]

EST] [timezone] No
EST] [s¥3.registry]
EST] [sv3.registry]
EST] [s¥s] Baja run
EST] [s¥3] Loading
EST] [s¥s] Loaded (
EST] [alarm.databas
EST] [alarm.databas
EST] [sy¥s] Services
EST] [3ys.mixin] Ug|
EST] [sys.mixin] TUp|
EST] [web.server] H|
EST] [fox] FOX serwv|
EST] [s¥s] Niagara
EST] [sy¥3] *** Stat|

EST] [web.server] H|
EST] [history.db] S

EST] [history.db] A
EST1[fox] Closing

[ Auto-Start
Restart on Failuy

Restart

Rebookt

Dump Threads|
Save Bog
Verify Softwarg

Clear Qutput

Step2  Right-click the demo station.

From the popup menu, click Stop (or, with the demo station selected, click the right-side Stop button).

il

[=

=

Connected to localhost

,_:‘I_I|

Restart !

fox=n/a,foxs=n/a,http=n/a,https=n/a

false

>

MESSAGE [16:41:20 10-Nowv-13
MESSAGE [16:41:20 10-Now-13
MESSAGE [16:41:20 10-Now-13
MESSAGE [16:41:20 10-Now-13
MESSAGE [16:41:20 10-Now-13
ptid: | MESSAGE [16:41:20 10-Now-13
MESSAGE [16:41:20 10-Now-13

EST] [alarm.datal
EST] [ay3] Servi
EST] [sys.mixin]
EST] [ay3.mixin]
EST] [web.server]|
EST] [fox] FOX =4
EST] [sy3] Niagay

Restart on Failure

MESSAGE [ Kill 13 EST] [ays] Baja 7= |[] Auto-Start
MESSAGE [ 13 EST] [sys] Loadig

MESSAGE [| C®FOUPUt 03 pET)[aya] Loaded

m{ |MESSAGE [I8:dT:Z0 10-Wov-13 EST] [alarm.datal |

Step3 A confirmation dialog appears. Click Yes.

=) [=
|| connected to localhost
d
51 demoAppliance station Ide fox=n/a,foxs=n/a,http=n/a,https=n/a falg
< [ |
o . .
TRRNTHG [] & Stopping station demo (=58 o | avto-start
MasecE IfF 4 ¥ ol Restart on Fai
MESSRGE [§ J14 Do you wish to stop station demo? (7Y =R G
™ | szseace | e I ETT
MESSAGE [ Ing
n | |amssace [ D] w | A —T—
MESSRAGE [ [bas
MESSAGE [16:41:20 I0-Now-13 EST|[alarm.databas Restart

NiagaraAX'3‘8
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Troubleshooting the Demo

Demo Quick Start

Tree not visible

Note:

Step 4

The demo station status changes to “Stopping,” then to “Idle

=

= |z | Nav

Connected to localhost

(e [@wel]

=52 My Host : sc-400 (demo)
My File System
10 My Modules
latform
g | Certificate Managem
4” DDNS Configuration
A Lexicon Installer

| License Manager
- |54 Platform Administrati
() Software Manager
- TCR/IP Configuratior|
& User Manager
[i== Remote File System
“Jz Station (dema)

Mame Type |Status|Details

< |

MESSLGE 10-Nov-13 EST] [fox] Reject]~|[]Au
WARNING 10-Nov-13 EST] [fox] Closin|
WARNING 10-Nov-13 EST] [fox] Closin| Flre
WARNING 10-Nov-13 EST] [fox] Closin
WARNING 10-Nov-13 EST] [fox] Closin
MESSLGE 10-Nov-13 EST] [fox] Reject
WARNING 10-Nov-13 EST] [fox] Closin| |:
WARNING 10-Nov-13 EST] [fox] Closin
WARNING 10-Nov-13 EST] [fox] Closin|
MESSAGE 10-Nov-13 EST] [fox] Reject]
WARNING 10-Nov-13 EST] [fox] Closin|
MESSAGE 10-Nov-13 EST] [console] Qul
MESSRAGE 10-Hov-13 EST] [sys] Saving] | @
MESSLGE 10-Nov-13 EST] [sya] Saved E
MESSLGE 10-Nov-13 EST] [sys] Statio)
MESSRGE 10-Hov-13 EST] [fox] Serwvic| Veri
WARNING 10-Hov-13 EST] [web.server]
MESSAGE 10-Nov-13 EST] [web.aserver] —_—

November 14,2013

7 The station is now stopped.

Ifyou had the demo station opened in Workbench, notice that it is now “ghosted” and collapsed. You cannot
open (connect) to the demo again until you first start the demo station, using this Platform view (Appli -
cation Director).

If finished looking at NiagaraAX, you can simply click the Windows “Close” control (X in upper right) to

exit as shown, or to exit from the menu bar, select File > Exit.

==

&5 localhost n

fox=1911,foxs=4911,http=80,https=443
fox=n/a,foxs=n/a,http=n/a https=n/a

false

When starting Workbench the next time, your host PC will be collapsed again in the Nav tree.
To restart the demo, expand your host in the tree and double-click the ghosted Platform, then continue

from Step 3 on page 2. Or, begin anew with “Get the Demo Up and Running”.

= |2 |Nav

D2 [@w
EHEE My Host @ 5c-400 (dema)
== My File System

5 My Modules

Station gemo)

Niagara Workbench
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Troubleshooting the Demo

Possible demo issues are covered in the following sections:

«  Tree not visible

WORKBENCH

+  Cannot open Platform
»  Stations missing in Application Director
«  Cannot open Station

Tree not visible

Symptom: Workbench starts up without the left-side tree (Nawv tree in side bar area), showing only a
single pane with view. This occurs if Workbench was last used with side bars “not shown”
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Troubleshooting the Demo

November 14, 2013

Note:

Cannot open Platform

To fix this, from the menu bar, select Window > Side Bars > Show Side Bar

b3 Niagara Workbench
File Edit Search Bookmarks Tools Help
< |0 o D
‘ @ » PathBar Uses NavFile El Bookmarks j
o Active Plugin @ Help =
P + Hide Consale 4 Jobs
£ ol
- : Console t | Nav
Bl My Host : sc-400 ) Palette s
Todo List
I

It is also possible that the side bar area is visible, but the Nav tree does not show. In this case, select
Window > Side Bars > Nav

From theWindow > Side Bars menu, additional items are selectable to see in the left pane (sidebar).

Cannot open Platform
Symptom: Authentication dialog keeps reappearing after you click OK.
& Authentication (3]
ﬁ' Login Failed
Realm
MName 5C-400
Scheme  HTTP-Basic
Credentials
Usermame
passverd
[[] Remember these credentials

Cause: Typically, using the default platform “Basic authentication’, your entered username and password
do not match alocal user who is a member of the local Windows machine’s Administrators group.

To fix: Confirm Windows administrator privileges for the PC, then re-enter your Windows credentials.

Symptom: Nothing happens for a few seconds, and “Cannot display page” appears in the view.
Text “Cannot connect. Ensure server is running on specified port” displays.

e
* & [Nav

D8
BT ot =00

BFi==| My File System
B My Modules
- =] Platform

Cannot display page

local: |platformssl:

Cannot connect. Ensure server is running on specified port,

Cause: The Niagara Platform Daemon (service) is not running on your PC. This occurs if in the last
NiagaraAX installation step, you unchecked “Install and Start Platform Daemon”. The platform daemon
(service) is needed for local platform/station operations.

To fix: Install the platform daemon and retry connection (next).

1-11

Step 1 From the Windows Start menu, select:
Start > All Programs > Niagara 3.8.nn > Install Platform Daemon
y_/i__ Adobe Acrobat Distiller . Maintenance
o Niagars AX 3834 |
I:II_'% Workbench (Console) £ Alarm Portal 3.8.34
& Console l
@/ Snagit 11 [="] Demo Station
— 1 [ Install Platform Daemon
| » Al Programs | 7
] %33 Uninstall
;% Workbench (Console)
3 Workbench 3.8.34
| 41 Back
Step2  In Workbench, retry “Open Platform” to your host (Step 2 on page 2).
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Stations missing in Application Director November 14,2013

Note:

Stations missing in Application Director

Symptom: After opening alocal Platform connection and accessing the Application Director,you
do not see any stations listed—including the demo station. This may occur if Workbench is being run in
a small sized window (similar to one used in screen captures in this document).

To fix this, drag (click and hold) downwards on the divider at the top of the Application Director
view.

= N = |

q (\./I]“ [ Auto-Start =
F | [F1 nantart an Cailirn H

[ Auto-Start
Restart on Failure
Start

[

Release after you see stations listed—for example the demo station.

Cannot open Station
Symptom: Authentication dialog keeps reappearing when you click OK.
i Authentication @I
%‘ Login Failed
Realm
MName local: [foxs:

Scheme  Fox (digest)
Credentials

Username admin

[[] remember these credentials

Likely cause: Username and password do not match the station’s stored credentials for the admin user.

+  Username: admin

«  Password: type the password entered in the last “Reset Password” popup dialog for user admin, or else
the password changed for the admin user from another station view, such as the User Manager.

To fix: Re-enter login credentials last used to access the station as user admin.

If the demo station’s admin account password has never been changed, you can leave the Password field
blank (empty). This produces the “Reset Password” dialog to change this password. See Step 8 on page 6.

In some cases where the demo station has been previously accessed and configured, the well-known admin
user may have been deliberately disabled, and some other ‘super user” created or enabled in place. In this
scenario, login using the credentials (Username and Password) for that user instead.

See “Demo stations security notes” on page 1-13.
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Demo stations security notes

Station security changes were made in the AX-3.8 development cycle that affect the standard “demo”
station typically installed with NiagaraAX Workbench (as well as the “demoappliance” station). For the
most part these stations remain unchanged from previous releases, meaning that the various default
users, including the “admin” user, still have a default “blank” (empty) password.

Such users include the “adminwbBasic” user, “adminHxDefault” user, and so on—all of which are “super
users” These users exist to demonstrate different “Web Profiles” when accessing the station via a browser.
Obviously, this combination of “well known” super users, each with a default blank password, is not a
good security practice to maintain.

Note: For proper security in a production system, the usage of “super users” in a station should be minimized, as
explained in various NiagaraAX documents, including the NiagaraAX Hardening Guide.

Note that login access of the demo station as any of these users, either from Workbench or a browser, now
prompts to reset the password. This happens because the AX-3.8 demo station now has all station users
configured for password reset. Once a new password is entered, that super user has full access to the
station—just as the “admin” user has.

Therefore to prevent any “unauthorized access” of a demo station, it is strongly recommended that after
first accessing the station as the admin user, that you do one of the following:

«  Change the password for each “well-known” default user (adminwbBasic, adminFrames, etc.). You
can do this by double-clicking each user in the station’s User Manager view, for the Edit dialog.

»  Typically, you specify the same strong password that you previously entered for the admin user.

+  For each user, you also need to set the “Force Password Reset” entry from true to false.
Otherwise upon the first login as that user, the Reset Password dialog would reappear.

Make sure to Save the changes to each of these users.

+  Disable any of these “well-known” default users, which you can also do by double-clicking each user
in the station’s User Manager view. Then set the user’s Enabled property to false, and Save.
Note: Starting in AX-3.7, you can disable the user admin—where previously you could not. However,
before doing this, be sure you have at least one working “super user” in the station.

Be sure to Save changes to the station after making user adjustments—right-click the ¥ Stationnode
in the Nav tree and select Save Station.

For more details about station security in NiagaraAX, see “About Security” in the NiagaraAX User Guide.

SSL and certificate notes in AX-3.8

Note: This section explains a little more about the Workbench SSL certificate warnings seen in the section “Get
the Demo Up and Running” on page 1-2. Note that in AX-3.8, a few SSL-related changes were made since
the releases for AX-3.7/AX-3.7ul that affect the ‘demo” station, which are also described below.

It is safe to “Accept” the certificate (Identification Verification)warningsseen in
Workbench when following steps in this document. However, don’t assume that always accepting similar
certificates is the correct choice. An overview with a few background details is below. For complete details
about SSL and NiagaraAX, refer to the NiagaraAX SSL Connectivity Guide.

Since AX-3.7, NiagaraAX has included integral support for industry-standard Secure Socket Layer
(SSLv3) and Transport Layer Security (TLSv1) protocols, via an “SSL Toolset” Included are Workbench
tools for managing PKI (Public Key Infrastructure) digital certificates or “self-signed” digital certificates,
which are used in verifying SSL connections. When you install NiagaraAX on your PC, a local self-signed
“tridium” certificate is generated, and is available for (default) local SSL usage.

+ InAX-3.7 (and AX-3.7ul), after installing NiagaraAX on your PC, you could optionally enable SSL
for your local PC platform, by making a local platform connection and accessing the Plat form
Administration view. By default, the “tridium” certificate is presented to any Workbench cli-
ent that attempts an SSL platform connection.

+ In AX-3.8 this changed—now when you install NiagaraAX, platform SSL is automatically enabled
for you Workbench PC platform—by default using the self-signed “t ridium” certificate. In addition,
changes were made to the standard “demo” station in AX-3.8 to enable SSL for station access (“Foxs
Enabled” in the station’s Fox Service), as well as SSL for browser access (“Https Enabled” in the sta-
tion’s Web Service)—again, (by default) both reference the self-signed “cridium” certificate.
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SSL and certificate notes in AX-3.8 Demo Quick Start

Browser access notes

Note:

November 14,2013

In either case just described, when you open the first platform SSL connection from Workbench (the
client) to your local platform daemon (a server), Workbench presents a warning “Identity Verifi-
cation” popup that shows you the details of your local self-signed “tridium” certificate.

+ IfyouAccept, an “allowed host” exemption is created for your Workbench (client), and you pro-
ceed to the Authentication dialog to enter your platform credentials. This warning should not
appear again unless you delete the allowed host exemption, or unless the certificate expires.

+ IfyouReject, no exemption is created, nor do you see the Authentication dialog to make a
connection. Instead, an error message is generated.

Note this Workbench certificate warning repeats when you open the first station SSL connection (Foxs)
to alocal station—in this case to your AX-3.8 “demo” station. When you Accept, another “allowed host”
exemption is created for your Workbench client, this time for a different software port: 4911 Foxs default,
(vs. 5011 platformssl default). Similarly, web browser access using a secure connection produces a
warning in your client browser; see “Browser access notes”.

In general, usage of PKI signed certificates with NiagaraAX is recommended over the (default) self-
signed “tridium” certificate. However, details are well outside the scope of this document. Again, refer
to the NiagaraAX SSL Connectivity Guide for complete details.

Browser access notes

Additionally, if you access your local AX-3.8 “demo” station using a secure web browser connection
(https:/Nlocalhost if using the default WebService “Https Port” of 443), your web browser (client) will also
issue its own certificate warning for this self-signed “tridium” certificate, asking if you wish to proceed.
Again, proceeding should be safe in this instance.

(Unrelated to SSL) If you access any AX-3.8 station with a web browser as a user with a “Wb Web” profile,
that is “Web Workbench’, in order for the Java-based “WbApplet” to load, your browser client PC requires
“unlimited strength policy files” in its Java installation. For more details, refer to “Additional AX-3.8 client-
side Java installation steps” in the latest NiagaraAX 2013 Security Updates document.
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